
ShoreTel Contact Center
Installation Guide

RELEASE 6USER GUIDES



Document and Software Copyrights
Copyright © 1998-2010 by ShoreTel Inc., Sunnyvale, California, USA. All rights reserved. 

Printed in the United States of America. Contents of this publication may not be reproduced or 
transmitted in any form or by any means, electronic or mechanical, for any purpose, without prior 
written authorization of ShoreTel, Inc. ShoreTel, Inc. reserves the right to make changes without notice 
to the specifications and materials contained herein and shall not be responsible for any damage 
(including consequential) caused by reliance on the materials presented, including, but not limited to 
typographical, arithmetic or listing errors.

Trademarks
ShoreTel, ShoreCare, ShoreGear, ShoreWare and ControlPoint are registered trademarks of ShoreTel, 
Inc. in the United Sates and/or other countries. The ShoreTel logo and ShorePhone are trademarks of 
ShoreTel, Inc. in the United States and/or other countries.

All other copyrights and trademarks herein are the property of their respective owners.

Patents
This product is covered by one or more of the following patents: United States patent 6,996,059, 
United States patent 7,003,091, United States patent 7,167,486, United States patent 7,356,129, 
Canadian patent 2,316,558, United States patent 7,379,540, United States patent 7,386,114, United 
States patent 7,450,574 and United States patent 7,450,703. The product is also covered by other 
pending patent applications. ShoreTel, Inc. All rights reserved.

Version Information
ShoreTel Contact Center Installation Guide
Release 6
Part Number: 850-1220-01
Version: GA 1

Company Information
ShoreTel, Inc.
960 Stewart Drive
Sunnyvale, California 94085
Telephone: (408) 331-3300
Fax: (408) 331-3333
www.shoretel.com



Contact Center 6 3

Table of Contents

PREFACE 7

CHAPTER 1:  INTRODUCTION 9
1.1 Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
1.2 Contact Center Features  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

1.2.1 Call Routing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
1.2.2 Monitoring . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
1.2.3 Performance Measurement. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
1.2.4 Agent Tools. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

1.3 Contact Center Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
1.3.1 Contact Center Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
1.3.2 Supervisor Suites  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
1.3.3 Agent Suite . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

CHAPTER 2:  HARDWARE AND SOFTWARE REQUIREMENTS 17
2.1 ShoreTel Contact Center Server Requirements . . . . . . . . . . . . . . . . . . . . . . . . . 17

2.1.1 Server Allocation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
2.1.2 System Requirements for 1 to 149 Simultaneous Agents . . . . . . . . . . . . . . . . . . . . . . . . . . 18
2.1.3 System Requirements for 150 to 299 Simultaneous Agents . . . . . . . . . . . . . . . . . . . . . . . . 18
2.1.4 System Requirements for 300 to 600 Simultaneous Agents . . . . . . . . . . . . . . . . . . . . . . . . 19
2.1.5 Operating Systems for Stations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
2.1.6 Processors and Memory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
2.1.7 Remote Access  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

2.2 ShoreTel Contact Center Clients . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

CHAPTER 3:  INSTALLING CONTACT CENTER 23
3.1 Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
3.2 Installation Prerequisites . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
3.3 Required Installation Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

3.3.1 Server Static IP Addresses. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
3.3.2 Partitioning the Contact Center Server Hard Disk. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
3.3.3 Power Source  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
3.3.4 Agent Workstation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
3.3.5 Data Execution Prevention Setting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
3.3.6 Contact Center Server Lock Device . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
3.3.7 Supervisor Licenses  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

3.4 Installing the Distributed Server Software. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
3.5 Installing the Contact Center Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
3.6 Starting and Verifying the ShoreTel Contact Center Server  . . . . . . . . . . . . . . . 30
3.7 Installing the Contact Center Supervisor Applications . . . . . . . . . . . . . . . . . . . 30

3.7.1 Manually Installing the Contact Center Supervisor Applications  . . . . . . . . . . . . . . . . . . . 31
3.8 Starting the ShoreWare Supervisor Applications  . . . . . . . . . . . . . . . . . . . . . . . 33



Installation Guide Table of Contents 

4

3.9 Installing ShoreWare Agent Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
3.9.1 Manually Installing ShoreWare Agent Toolbar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

3.10 Starting ShoreWare Agent Toolbar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
3.11 Installing the Ghostscript Component (Optional). . . . . . . . . . . . . . . . . . . . . . . 38
3.12 Installing Distributed IVR Servers (Optional) . . . . . . . . . . . . . . . . . . . . . . . . . . 42
3.13 Specifying an External Location for Interaction Data (Optional)  . . . . . . . . . . . 43
3.14 Installing Contact Center in a Thin Client Environment. . . . . . . . . . . . . . . . . . 46

3.14.1 Installing and Configuring Agent Toolbar in a Thin Environment . . . . . . . . . . . . . . . . . . 46
3.15 Uninstalling Contact Center  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

3.15.1 Uninstalling the Contact Center Server and Database Directories. . . . . . . . . . . . . . . . . . . 47
3.15.2 Uninstalling the Contact Center Client Applications. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

CHAPTER 4:  CONFIGURING CONTACT CENTER 49
4.1 Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
4.2 Setting Up User Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
4.3 Identifying Server Route Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

4.3.1 Creating IRN Route Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
4.3.2 Creating IVR Route Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

4.4 Specifying Supervisor Licenses  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
4.5 Setting Up Agent Phones . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
4.6 Setting up Data Sources used by ODBC Connections . . . . . . . . . . . . . . . . . . . . 58
4.7 Preparing to use CCIR and Event Feeds (Optional)  . . . . . . . . . . . . . . . . . . . . . 58

CHAPTER 5:  TESTING CONTACT CENTER 59
5.1 Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
5.2 Creating a Supervisor. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
5.3 Adding an Agent. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
5.4 Configuring an Agent Group . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

5.4.1 Creating a Group  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
5.4.2 Add an Agent to the Group  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
5.4.3 Assigning a Service to the Group . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

5.5 Creating an IRN . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
5.6 Configuring an IVR Port  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

5.6.1 Verifying the Call Center Can Receive Calls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
5.7 Verifying an Inbound Call Reaches an Agent. . . . . . . . . . . . . . . . . . . . . . . . . . . 69

5.7.1 Logging on as an Agent  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
5.7.2 Calling into the System. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

CHAPTER 6:  UPGRADING, MAINTAINING, AND TROUBLESHOOTING 71
6.1 Upgrading Contact Center . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

6.1.1 Upgrading the Contact Center Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
6.1.2 Upgrade Methods for Client Applications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

6.2 Backing Up Contact Center . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73
6.2.1 Automatically Backing Up Contact Center  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
6.2.2 Manually Backing Up the Contact Center Database. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

6.3 Restoring Contact Center. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
6.3.1 Restoring Contact Center Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
6.3.2 Restoring the Entire Contact Center System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
6.3.3 Moving the Contact Center Installation to a New Server Partition . . . . . . . . . . . . . . . . . . 77



Table of Contents Installation Guide

Contact Center 6 5

6.4 Troubleshooting Contact Center . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
6.4.1 Error 1720  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
6.4.2 TMS or DTAS Error  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

APPENDIX A:  INSTALLATION WORKSHEETS 79
A.1 Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
A.2 Site General Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
A.3 Contacts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
A.4 About the Company . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
A.5 Network Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
A.6 ShoreWare Agent Manager Computers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80
A.7 ShoreWare Agent Computers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

GLOSSARY 83

INDEX 87



Installation Guide Table of Contents 

6



Contact Center 6 7

Preface

This preface provides information about the objectives, audience, and conventions of the 
ShoreTel Contact Center Installation Guide. 

This guide is not intended as a user guide for the ShoreTel Contact Center Solution. It 
does not describe how to use the system applications in detail. For such information, refer 
to the other Contact Center documentation, as described in the Documentation section on 
page 8.

Objectives
This document describes how to get your ShoreTel Contact Center system up and running. 
In this guide, you will find:

• Introduction to Contact Center

• Hardware and software requirements

• Installation instructions

• Directions on configuring Contact Center

• Information on testing the Contact Center system

• Details on setting up a redundancy server system

• Overview on upgrading and maintaining Contact Center

• Installation worksheets

• Glossary

Audience
This guide is intended for professional services engineers or technical personnel 
responsible for system installation. The guide also provides getting started information for 
contact center administrators and other system users, as well as a basic overview of the 
applications that make up the system. 

Guide Conventions
Conventions used in this guide include the following:

• Data-entry field names, hypertext links, control buttons, keywords, and other items 
within the system management interface are in boldface text.

• Information that you enter in data-entry fields is in a data entry font.

• NOTE indicates an area of special interest to the user. 
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Other Contact Center Documentation
The following documents offer additional information about the Contact Center system:

• Release Notes

• Administrator Guide

• Applications Interface Guide

• Installing and Implementing Enterprise Contact Center Chat

• Supervisor Guide

• Report Data Fields Reference Guide

• Using ShoreWare Agent Toolbar

• Context-Sensitive Online Help

Contact Center documentation can be found in the Documentation folder of the ShoreTel 
Contact Center Solution Installation CD and on the ShoreTel web site. The context-
sensitive online help can be accessed from the Help menu of each Contact Center 
application.
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C H A P T E R 1

Introduction

1.1 Overview
ShoreTel Contact Center is a comprehensive solution designed to control, manage, and 
monitor the various activities of a call center. ShoreTel offers two Contact Center solutions 
to address the requirements of customer service organizations:

• Contact Center targets medium-sized inbound Automatic Call Distributor (ACD) 
installations and supports large agent groups with inbound routing rules, real-time 
agent monitoring, historical reports, and wallboard administration.

• Enterprise Contact Center meets the needs of the most complex inbound-
outbound, multimedia call centers by extending the capabilities of Contact Center 
with a powerful, rules-based routing engine that supports customizable skill sets 
and multimedia communications, and smoothly integrates with customer 
relationship management (CRM) solutions.

All Contact Center components are included in both Contact Center and Enterprise 
Contact Center. 

1.2 Contact Center Components
The Contact Center Solution includes the following basic components:

• Contact Center Server
• One or more PCs with Full Supervisor Suite
• One or more PCs with Monitor Supervisor Suite
• One or more PCs with Agent Suite

The software modules installed with the each type of component are:

Module Server
Full 
Supervisor

Monitor 
Supervisor Agent

ShoreWare Contact Center Director X X

Contact Center Diagnostics Console X

ShoreWare Contact Center Reports X X

License Viewer X X X

ShoreWare Wallboard Director X X

ShoreWare Agent Manager X X X

ShoreWare Agent Toolbar. X X X

Graphical Contact Center Scripting X X
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1.2.1 Contact Center Server
The Contact Center Server software provides an intelligent routing engine and an 
integrated interactive voice response (IVR) package for managing call center configuration, 
call activity, and reporting, and for implementing the required routing plan. The server 
software runs on a dedicated server at your call center.

The Contact Center Server may be at the same location as the ShoreWare Headquarters 
Server. The Contact Center Server is a ShoreWare distributed server with the Contact 
Center Server software also installed. In a production environment, the Contact Center 
applications should not be run from the Contact Center Server.

The Contact Center Server interacts with the ShoreTel system as a TAPI application.

1.2.2 Supervisor Suites
The Supervisor Suites are used to administer and monitor call center activities, and to 
report on real-time and historical information that details or summarizes the system’s 
performance over a specified time period. Supervisors cannot start or stop the system.

Two Supervisor Suite versions are available to customize the access levels and permissions 
that personnel that have to Contact Center administration, configuration, and maintenance 
features:

• Supervisor Monitor. For supervisors that only monitor call center activities, this 
suite includes ShoreWare Agent Manager, ShoreWare Agent Toolbar, and the 
License Viewer.

• Full Supervisor. For supervisors who also administer Contact Center, this suite 
provides access to all supervisor applications and ShoreWare Agent Toolbar.

The Contact Center supervisor applications are:

• ShoreWare Contact Center Director is used to configure the Contact Center 
entities and set system parameters.

• Graphical Contact Center Scripting (GCCS) is a tool for designing script 
functions used in call input based call routing (available in Enterprise Contact 
Center only).

• ShoreWare Agent Manager furnishes real-time statistical information on call 
center activities. The information can be displayed in tables, forms, and graphical 
formats. 

• ShoreWare Contact Center Reports generates predefined and custom reports on 
historical call center activity. With this information, management can efficiently 
allocate personnel to meet call center requirements. 

• ShoreWare Wallboard Director displays messages on a third-party wallboard 
display, or on an agent’s PC (with the integrated Desktop Wallboard software).

• Contact Center Diagnostics Console indicates system status and alarms.

• License Viewer displays the license features and quotas.

1.2.3 Agent Suite
The Agent Suite, made up of ShoreWare Agent Toolbar, is installed on agent PCs. 
ShoreWare Agent Toolbar provides the agent with an easy-to-use environment for 
performing basic and sophisticated tasks.
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1.3 Licensing
A server lock device, also known as a license dongle, is required to install and use Contact 
Center 5 or higher on a server. The lock device is encoded with the purchased Contact 
Center version and provides access to specific features. For installations that use the new 
dongle-less supervisor licensing scheme, the number of supervisor licenses is also encoded 
in the server lock. The restrictions encoded in the lock device limit access to Contact 
Center features and administrative functions to authorized individuals only.

The server lock is installed on the server that runs the Contact Center Server software. 

Note: When you add a new License Key file (.cif), you must shut down and restart the 
Contact Center Server service to propagate the changed information throughout the entire 
system. To properly shutdown the Contact Center Server service, select Start > Programs > 
Administrative Tools > Services, and then click Stop the Service.

1.3.1 Server Lock Devices
ShoreTel offers two Contact Center solutions: Contact Center and Enterprise Contact 
Center. There is a server lock device for each solution: 

• Server with Contact Center: Required to run the server software. Includes 
configuration information about the product you have, such as the number of 
supervisors and agents and any additional features you purchased. Optional features 
are licensed on a per-system basis and consist of: 

• Wallboard Support 

• Desktop Wallboard Access

• Formula Editor

• Work Force Management Connector

• Server with Enterprise Contact Center: Required to run the server software. Includes 
configuration information about the product you have, such as the number of 
supervisors and agents and any additional features you purchased. Optional features 
are licensed on a per agent basis and require a license for every agent who logs into a 
group that supports these features:

• Voice

• Email

• Chat

• Outbound Calling

The number of permitted agents is encoded in the server lock device. The number of agent 
licenses must equal the maximum number of agents that could be logged into Contact 
Center at one time.

Each IVR port has its own license in Enterprise Contact Center. The number of IVR ports is 
encoded in the server lock device. You need an IVR port license for every IVR port 
configured in the system. The total number of licenses must match the maximum number 
of calls connected to the system at one time. A call is connected to an IVR port whenever a 
call is waiting in a queue or being serviced by a call control script (CCS) or announcement.

Each inbound voice license includes an IVR port license. This provides a trunk-to-agent 
ratio of 2:1, such that for every call being answered by an agent, another call is queued in 
an IVR port. Additional IVR port licenses are required if either more than one call is queued 
per agent or if there is a self service module. 
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1.3.2 Supervisor Lock Devices
Beginning with Contact Center 5, supervisor licences are encoded in the server license, so 
the server lock device for each supervisor is no longer necessary. Customers upgrading to 
release 5 and higher have the option of continuing to use supervisor license dongles.

Two types of supervisor lock devices exist:

• Full Supervisor: Used to access all supervisor applications. Requires a separate license.

• Monitor Supervisor: Used to access a subset of supervisor applications. Requires a 
separate license. 

1.3.3 Viewing Licensing Information
You can view the Contact Center license information using the License Viewer.

To view license information:

Step 1 From the Windows desktop, click Start > Programs > ShoreTel > Contact 
Center > License Viewer.

The License Viewer appears. 

Step 2 Click the appropriate tab to view information on the permissions that have 
been licensed.
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C H A P T E R 2

Hardware and Software
Requirements

2.1 ShoreTel Contact Center Server Requirements
ShoreTel Contact Center Server software must be installed on a dedicated computer that 
meets or exceeds the hardware and software requirements in this chapter and is attached to 
the network. This chapter defines three levels of requirements, based on the type of call 
center, normal loads, and activity. 

For high call loads and advanced interactive voice response (IVR) activity, including large 
numbers of Dialed Number Identification Services (DNIS), more than 150 concurrent 
agents, and more than 1,000 calls per hour, please contact ShoreTel Customer Service. The 
support of more the 150 simultaneous users, or more than 1,500 simultaneous media ports, 
requires multiple servers to separate the core Contact Center, Enterprise Contact Center, 
and IVR engines.

Contact Center runs as a Microsoft Windows service, with multiple child processes, and 
conforms to standard service semantics (for example—Start, Stop, and Restart). 

Depending on how your call center is set up, and the location of your agents, the server 
allocation recommended in this chapter should be followed to reduce latency. 

Note: Blade Servers are not supported with Enterprise Contact Center since the server 
needs a dedicate USB port for the lock device.

2.1.1 Server Allocation
Generally, you want to have your HQ (PBX HQ) and ShoreWare Contact Center servers in 
the same physical location. However, if your call center includes agents in a remote 
location using a DVS (PBX remote server), the ShoreWare Contact Center Server should be 
at the remote location to reduce network latency and improve agent experience with 
Contact Center. 

It is highly recommended that the site which has the Contact Center server always have 
either an HQ server or a DVS server that the agents at the site are associated with. 
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2.1.2 System Requirements for 1 to 149 Simultaneous Agents
The following components are required to support Contact Center Server software for a 
maximum of 149 agents:

• One Core Duo Processor Server 

See Section 2.1.6 on page 21 for information on the server processor requirements.

• Memory 

See Section 2.1.6 on page 21 for information on the memory requirements.

• Hard Drive 1 

Configured with 73 GB, U160, SCSI, 1 In, 10 K RPM HDD. All drives must match 
for RAID configuration.

• Hard Drive 2 

Configured with 73 GB, U160, SCSI, 1 In, 10 K RPM HDD. All drives must match 
for RAID configuration.

• Hard Drive Redundancy 

RAID required. Add-in RAID card, RAID 1.

• DVD 

• Keyboard 

A standard Windows keyboard.

• Monitor

• Mouse

• First Network Adapter (TCP/IP)

• Second Network Adapter (TCP/IP) (Optional)

• Serial Port #1 

• Serial Port #2 (Optional)

For wallboard integration

• USB1 Port (License lock device/dongle)

• Operating System 

See Section 2.1.5 on page 20 for details.

2.1.3 System Requirements for 150 to 299 Simultaneous Agents
The following components are required to support Contact Center Server software for a 
maximum of 299 agents:

• Three Core Duo Processor Servers 

One server to run the main Contact Center core engine; two servers to run 
standalone distributed IVR ports (150 ports in each server). 

See Section 2.1.6 on page 21 for information on the server processor requirements.



 ShoreTel Contact Center Server Requirements Installation Guide

Contact Center 6 19

• Memory 

See Section 2.1.6 on page 21 for information on the memory requirements.

• Hard Drive 1 

Configured with 150 GB, U160, SCSI, 1 In, 10 K RPM HDD. All drives must match 
for RAID configuration.

• Hard Drive 2 

Configured with 150 GB, U160, SCSI, 1 In, 10 K RPM HDD. All drives must match 
for RAID configuration.

• Hard Drive Redundancy 

RAID required. Add-in RAID card, RAID 1.

• DVD 

• Keyboard 

A standard Windows keyboard.

• Monitor

• Mouse

• First Network Adapter (TCP/IP)

• Second Network Adapter (TCP/IP) (Optional)

• Serial Port #1 

• Serial Port #2 (Optional)

For wallboard integration

• USB1 Port (License lock device/dongle)

• Operating System 

See Section 2.1.5 on page 20 for details.

2.1.4 System Requirements for 300 to 600 Simultaneous Agents
The following components are required to support the Contact Center Server software for 
up to 600 agents.

• One Quad Core Xeon Processor Server and Four Core Duo Processor Servers 

One server to run the main Contact Center core engine; four servers to run 
standalone distributed IVR ports (150 ports in each server). 

See Section 2.1.6 on page 21 for information on the server processor requirements.

• Additional Processor (If required)

• Memory 

See Section 2.1.6 on page 21 for information on the memory requirements.

• Hard Drive 1 

Configured with 150 GB, U160, SCSI, 1 In, 10 K RPM HDD. All drives must match 
for RAID configuration.
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• Hard Drive 2 

Configured with 150 GB, U160, SCSI, 1 In, 10 K RPM HDD. All drives must match 
for RAID configuration.

• Hard Drive Redundancy 

Drives attached to PERC3-DI, RAID 5.

• Backplane

1X6 Hot-Pluggable HDD Backplane

• DVD 

• Keyboard 

A standard Windows keyboard.

• Monitor

• Mouse

• First Network Adapter (TCP/IP)

• Second Network Adapter (TCP/IP)

• Serial Port #1 

• Serial Port #2 (Optional)

For wallboard integration

• USB1 Port (License lock device/dongle)

• Power Supply Kit

Redundant Power Supply 2+1

• Operating System 

See Section 2.1.5 on page 20 for details.

2.1.5 Operating Systems for Stations
Contact Center requires the following operating systems:

Server station:

• Microsoft Windows Server 2003 (SP2)
• Microsoft Windows Server 2008 32-bit (SP2)

IVR Distributed Server station:

• Microsoft Windows Server 2003 (SP2)
• Microsoft Windows Server 2008 32-bit(SP2)

Supervisor station (for the Full Supervisor Suite):

• Microsoft Vista Business (SP2)
• Microsoft Windows XP (SP2)
• Microsoft Windows 2007 (32-bit and 64-bit) versions
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Agent station:

• Microsoft Vista Business (32-bit version only) (SP2)
• Microsoft Windows XP (SP2)
• Microsoft Windows 2007 (32-bit and 64-bit) versions
• Citrix Xenapps 4/4.5

Browsers Supported:

• Microsoft Internet Explorer 7.0 and 8.0, and FireFox 3.5.

2.1.6 Processors and Memory
The following table summarizes the server processor and memory requirements, based on 
the size of your call center.

For dual CPU configurations, use the following formula to estimate the total frequency of 
the system: (CPU#1_frequency + CPU#2_frequency) *0.8.

2.1.7 Remote Access
The Contact Center Server should be configured for remote access maintenance and 
support operations. You must enable Terminal Services on the server to allow 
administrators to connect using Terminal Services Client software. 

2.2 ShoreTel Contact Center Clients
ShoreTel Contact Center supervisor and agent applications run on the user’s PC alongside 
any other applications. 

The following table summarizes the requirements for client systems:

Core Duo Quad Core Xeon

Agents Software Type Minimum 
CPU

Minimum 
RAM

Minimum 
CPU

Minimum 
RAM

1 to 149 ECC / CC Core and IVR 1.8 GHz 2 GB

150 to 299 ECC / CC Core and IVR 2.0 GHz 4 GB

300 to 600 ECC / CC Quad Core 
and IVR

1.6 GHz 4 GB

Category Supervisor PC Agent PC

CPU Pentium III 500 MHz or
Pentium IV 1.6 MHz

Pentium III or Pentium IV

Memory 128 MB 128 MB

Hard Disk Space 500 MB free 300 MB free

CD Optional Optional

First Network Adapter 10/100 Mb 10/100 Mb

USB Port Required (license lock device)
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External Modem Optional

Operating System Windows XP / Vista/7 Windows XP / Vista/7

Outlook 2003 SP3 If a supervisors is using Outlook 
2003, required in order to use the 
Contact Center email feature

If an agent is using Outlook 2003, required 
in order to use the Contact Center email 
feature

Category Supervisor PC Agent PC
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C H A P T E R 3

Installing Contact Center

3.1 Overview
The chapter provides information on installing ShoreTel Contact Center. Details on 
installing Contact Center in a thin client environment, and uninstalling Contact Center, are also 
included.

The following process is used to install ShoreTel Contact Center:

1. Verify that the installation prerequisites have been met.

2. Gather the required installation information.

3. Install the ShoreTel Distributed Server software on the dedicated server.

4. Install the ShoreTel Contact Center Server software. 

5. Start the Contact Center Server and verify its operation.

6. Install the Contact Center supervisor applications on the supervisor PCs.

7. Check the installation of the Contact Center supervisor applications by starting the 
applications.

8. Install ShoreWare Agent Toolbar on the agent PCs.

9. Check the installation of ShoreWare Agent Toolbar by starting the application.

10. (Optional) Install the Ghostscript component.

11. (Optional) Install distributed IVR servers.

12. (Optional) Specify an external location to store interaction data. 

The ShoreTel Contact Center Solution DVD is used for all installations. The installation 
procedure determines which software to install from information on the lock device.

Once Contact Center has been installed, you need to configure and test the system. These 
activities are explained in Chapters 4 and 5 of this guide.

The Contact Center Server software and Contact Center applications support redundancy 
of the critical hardware components of the server. ShoreTel recommends redundancy of 
hard drives and power supplies to minimize system down-time and improve the recovery 
process in case of hardware failures. Refer to the Contact Center Administrator Guide for 
information on installing and using the ShoreTel redundant server system.
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3.2 Installation Prerequisites
Before beginning the Contact Center installation, verify that the following prerequisites 
have been met:

• A dedicated server is available for installing ShoreTel Contact Center Server.

• ShoreTel Contact Center Server has assigned static IP addresses.

• The Aladdin HASP driver (HASP4_driver_setup.zip) is installed on the server. 

The USB server lock device, required to install and use Contact Center 5 or higher 
on the server, uses the Aladdin HASP driver to automatically activate when pluged 
into a port. This driver resides on most computers. If necessary, you can download 
it from the Internet.

• A lock device (dongle) is available for the server.

• You have either type of Contact Center Supervisor licenses:

— Dongle-less supervisor license system (available with release 5 and higher). 

— Legacy physical dongles, if these are retained after an upgrade from release 
4.6x. 

• You are familiar with the Microsoft Windows 2003, 2007, or 2008 SP2 
environments.

• You have local administrator privileges to install and execute Contact Center 
applications on the Contact Center Server.

• If you plan to install Contact Center supervisor applications using the active 
directory method, Java 6 or higher must be installed on supervisor PCs (see the 
section Installing the Contact Center Supervisor Applications on page 30 for 
details).

All server and client computers must connect over a LAN that supports TCP/IP. ShoreTel 
recommends that you assign static IP addresses for the Contact Center Server. All other 
workstations (supervisors or agents) can use Dynamic Host Configuration Protocol 
(DHCP) if it is available.

3.3 Required Installation Information
Prior to installing the system components, make sure that you have the following required 
information:

• The Contact Center Server static IP addresses.

• The method for partitioning the server hard disk.

• Your power source.

• Specifics on agent workstations and telephone extensions.

• Whether you plan to implement Data Execution Prevention (DEP), for Microsoft 
Windows XP-based systems.

• Which supervisor licenses you will install.
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3.3.1 Server Static IP Addresses
The Contact Center Server should have static IP addresses. ShoreTel considers the 
assignment of static IP addresses for servers to be a best practice.

3.3.2 Partitioning the Contact Center Server Hard Disk
It is recommended that Contact Center software be installed in a separate partition. 
However this is not mandated by the installer.

The Contact Center Server hard disk can be partitioned as follows:

• Disk C: 16 GB includes the boot disk with the operating system and basic software.

• Disk D: The remainder of the hard drive is the application disk and includes the 
Contact Center Server software (for installation and data).

3.3.3 Power Source
Ensure that the Contact Center Server has a protected power source, such as an 
uninterruptable power supply (UPS) or a protected power source.

3.3.4 Agent Workstation
ShoreTel recommends that you collect and keep a record of the following information for 
each agent workstation on which ShoreWare Agent Toolbar runs:

• Device IP address or name

• User telephone extension

3.3.5 Data Execution Prevention Setting
Data Execution Prevention (DEP) is an optional feature in Microsoft Windows Server 2003 
and Microsoft Windows XP (SP2), but not Microsoft Windows Vista. DEP prevents 
applications or services from executing code from nonexecutable memory regions. DEP 
occasionally causes software problems with various applications, including Contact Center. 
When DEP is fully enabled, Contact Center may have operational delays.

To access the DEP setting:

Step 1 On your desktop, right-click the My Computer icon, and then click Properties on 
the pop-up menu.

Step 2  From the System Properties panel, click the Advanced tab.

Step 3  From the Performance section, click the Settings button. 

Step 4  From the Performance Options panel, click the Data Execution Prevention tab. 
The option Turn on DEP for essential Windows programs and services only is 
used to turn DEP on or off.

Step 5  Click on OK to save your change and to close the panels. 

Step 6  Reboot your computer for the DEP changes to take effect.
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3.3.6 Supervisor Licenses
To run a supervisor application, the system requires a supervisor license for each user who 
logs on as a supervisor. 

Beginning with Contact Center 5, supervisor licences are encoded in the server license, so 
the server dongle for each supervisor is no longer necessary. Customers upgrading to 
release 5 and higher have the option of continuing to use supervisor license dongles. Two 
types of supervisor licences are available:

• Supervisor Monitor. For supervisors that only monitor call center activities, this 
license includes ShoreWare Agent Manager, ShoreWare Agent Toolbar, and the 
License Viewer.

• Full Supervisor. For supervisors who also administer Contact Center, this license 
provides access to all supervisor applications and ShoreWare Agent Toolbar. Full 
Supervisor installations do not have access to the Contact Center Diagnostics 
Console or Contact Center Scripting. Full supervisors cannot start or stop the 
system.

Licenses of the same type can be used interchangeably on like installations. For example, if 
you use one supervisor license to install the supervisor applications, you can use a different 
supervisor license to access the applications after the installation.

Multiple supervisors can use the same PC, but only one supervisor can be logged on to that 
PC at a time. Supervisors can use multiple PCs with supervisor applications installed—but 
only if the server has an available supervisor license.

3.4 Installing the Distributed Server Software
Before installing the ShoreTel Contact Center Server software, you must install the 
ShoreWare Distributed Server software on the computer that is to run the Contact Center 
software. Refer to the ShoreTel Planning and Installation Guide for details.Before adding the 
distributed server, note the following:

• On systems containing two network interface cards (NICs), disable one card.

• Do not change the pre-set voice mail extensions.

• Do not enable or configure the Simplified Message Desk Interface (SMDI).

• Do not configure any users for voice mail on this server.

3.5 Installing the Contact Center Server
Before beginning the installation of the Contact Center Server, ensure that you have 
attached the correct lock device.

To install the ShoreTel Contact Center Server software:

Step 1 Verify that the server meets the basic requirements, as specified in Chapter 2.

Step 2  Verify that the server is connected to the network and has a static IP address.
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Step 3  If the computer contains two enabled NICs, disable the NIC not running the 
ShoreTel Remote Telephony Application Programming Interface (TAPI) Service 
Provider. 

Server computers containing two enabled NICs may not properly install or update 
Contact Center software. 

Step 4  Turn on the ShoreTel Contact Center Server.

Step 5  Log on as a Windows Administrator. 

You must install the software through a direct connection to the server. The 
Contact Center Server software cannot be installed through a Windows terminal 
server or remote desktop session.

Step 6  Insert the lock device in one of the server’s USB ports. 

If the device driver is not already installed, the installation program installs the 
required lock device driver. A small screen indicates this process and closes after 
the driver is installed. When you have installed the lock device correctly and the 
drivers are working, a red light inside the lock device turns on.

Step 7  Insert the ShoreTel Contact Center Solution Installation CD.

Step 8  In the CD’s ShoreTel Contact Center Server folder, click the setup.exe file. A 
Welcome screen appears. Click Next to continue. 

If you decide to stop the installation, click the Cancel button at any time 
throughout the process. If you want to return to the previous screen, click Back.

Step 9  You are asked to accept the terms of the license agreement. Then click Next.

Step 10 In the Destination Folder screen, click Next to keep the default destination and 
continue the installation. 

The default destination is C:\ShoreTel\Contact Center Server. 
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Alternatively, you can click Change to locate and select a different destination 
folder, and then click Next.

Step 11 In the resulting screen, click Install to begin installation of the server software. 

During the installation process, all files are installed into the appropriate 
directories. While the files are being installed, a status bar shows the progress of the 
process.

Step 12 In the resulting screen, click Finish to complete the server installation process.
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Step 13 A window opens offering a choice of restarting the system immediately or waiting 
until later. The new installation of the server software cannot run until the system 
restarts.
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3.6 Starting and Verifying the ShoreTel Contact 
Center Server
Starting with release 5.0, the ShoreTel Contact Center Server software runs as service. 
When the Microsoft Windows OS starts, it loads and starts the Contact Center Server 
services through the Windows Management Console.

Once you have started the server, you need to verify its operation. The Contact Center 
Diagnostics Console is a powerful yet easy-to-use tool that provides a quick look at the 
operational status of the system with its main components. Status information is available 
for viewing by all users authorized to log into the Server computer.

To start Contact Center Diagnostics Console, from the Server select Start > Programs > 
ShoreTel> ShoreWare Contact Center Server > Contact Center Diagnostics Console. The 
Contact Center Diagnostics Console displays LEDs indicating the status of various system 
components. Each LED has three colors (red, yellow, and green). When the Automatic Call 
Distribution (ACD), IVR, and Private Branch Exchange (PBX) LEDs are green, the system 
is operational. The Chat LED is yellow on systems not licensed for web chat. The online 
Help available from the ShoreTel Contact Center Diagnostics Console provides details on 
the information displayed. 

To properly shutdown the Contact Center Server, select Start > Programs > Administrative 
Tools > Services, and then click Stop the Service.

3.7 Installing the Contact Center Supervisor 
Applications
ShoreTel Contact Center’s supervisor applications can be installed either manually or 
through the active directory method that uses the Microsoft Installer (MSI). Manual 
installation involves using the ShoreTel Contact Center Solution DVD and installing the 
software on each individual PC. 

The active directory installation method simplifies deployments and reduces administrative 
costs. Contact Center is configured, using the Windows Group Policy Object (GPO), to 
automatically push from the server to all computers in your call center. You must have Java 
installed on your supervisor machines for the Contact Center supervisor applications to 
work after installation using the active directory method; and network connectivity is 
required during the installation process. To enable the active directory installation method, 
follow the instructions provided by MSI.
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3.7.1 Manually Installing the Contact Center Supervisor 
Applications
The process of manually installing the Contact Center supervisor applications is the same 
for both types of supervisor licenses (i.e. Full Supervisor or Monitor Supervisor). You can 
install the supervisor application on multiple PCs; however, a license for each supervisor 
position is required to access the applications. 

To manually install the Contact Center supervisor applications:

Step 1 Verify that the PC meets basic requirements, as specified in Chapter 2.

Step 2  Connect the server to the network through the LAN adapter. 

Step 3  Turn on the supervisor PC.

Step 4  Log on to the computer system as a local administrator.

Step 5  Insert the ShoreTel Contact Center Solution Installation CD. The installation 
process begins.

Step 6  Install the supervisor lock device by placing the lock device into the USB port of 
the supervisor PC. 

If the device driver is not already installed, the system automatically installs it. If 
the lock device and drivers are installed, then a red light inside the lock device 
turns on. See the section Supervisor Licenses on page 26 for information on 
supervisor licenses and the legacy lock devices (supervisor dongles).

Step 7  Click the setup.exe file in the CD’s ShoreTel Contact Center Supervisor folder. A 
Welcome screen appears. Click Next to continue.

If you decide to stop the installation, click the Cancel button at any time 
throughout the process. If you want to return to the previous screen, click Back.
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Step 8  You are asked to accept the terms of the license agreement. Then click Next.

Step 9  In the Destination Folder screen, click Next to keep the default destination and 
continue the installation. 

The default destination is C:\Program Files\ShoreTel\Contact Center. 

Alternatively, you can click Change to locate and select a different destination 
folder, and then click Next.

Step 10 In the resulting screen, click Install to begin installation of the software. 

During the installation process, all files are installed into the appropriate 
directories. While the files are being installed, a status bar shows the progress of the 
process.
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Step 11 In the resulting screen, click Finish to complete the installation process.

Step 12 A window opens offering a choice of restarting the system immediately or waiting 
until later. The new installation of software cannot run until the system restarts.

3.8 Starting the ShoreWare Supervisor Applications
The Contact Center Server must be running before you can start a Contact Center 
supervisor application. Do not start or run any of the Supervisor Applications from the 
Contact Center Server. Supervisor applications should be used only on a supervisor PC, 
based on the license key. Running these applications on the server causes unexpected 
errors and results.
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To start any of the ShoreWare Supervisor Applications:

Step 1 From a supervisor PC, select Start > Programs > ShoreTel> ShoreWare Contact 
Center Supervisor, and then choose the application you want to open. The 
supervisor application icons are:

Step 2  If this is your first time logging onto a supervisor application, you are asked to 
specify your Contact Center server, and then click OK.

Step 3  In the ShoreTel Contact Center Logon window, specify your login name, password, 
and server IP address, and then click OK.

You can use the default login name and password, which are:

• Default login name: ea 

• Default password: e1996

Each user should be assigned a unique login name and password. ShoreTel 
recommends that you assign different login names and passwords as soon as 
possible.

If your server is not listed in the drop-down menu, click Servers to add the 
server to the list. Use the resulting dialog box to add and remove servers from 
the list and to identify the default server.
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3.9 Installing ShoreWare Agent Toolbar
ShoreWare Agent Toolbar can be installed either manually or through an active directory 
method that uses the Microsoft Installer (MSI). Manual installation involves using the 
ShoreTel Contact Center Solution DVD and installing the software on each individual PC. 

The active directory installation method simplifies deployments and reduces administrative 
costs. Contact Center is configured, using the Windows Group Policy Object (GPO), to 
automatically push from the server to all computers in your call center. Network 
connectivity is required during the active directory installation process. To enable the 
active directory installation method, follow the instructions provided by MSI.

ShoreWare Agent Toolbar can also be installed in a thin client environment. See the section 
Installing Contact Center in a Thin Client Environment on page 46 for details.

3.9.1 Manually Installing ShoreWare Agent Toolbar

To install ShoreWare Agent Toolbar manually, follow these steps:

Step 1 Turn on the agent PC and log on as a local administrator.

Step 2  Connect the agent PC to the LAN. Then Unplug any accessories attached to LPT1 
or USB ports. 

Step 3  Insert the ShoreTel Contact Center Solution Installation CD.

Step 4  From the ShoreTel Contact Center Agent folder, click the setup.exe file. A 
Welcome screen appears. Click Next to continue. 

If you decide to stop the installation, click the Cancel button at any time 
throughout the process. If you want to return to the previous screen, click Back.

Step 5  You are asked to accept the terms of the license agreement. Then click Next.
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Step 6  In the Destination Folder screen, click Next to keep the default destination and 
continue the installation. 

The default destination is C:\Program Files\ShoreTel\Contact Center\Agent. 
Alternatively, you can click Change to locate and select a different destination 
folder, and then click Next.

Step 7  In the resulting screen, click Install to begin installation of the software. 

During the installation process, all files are installed into the appropriate 
directories. While the files are being installed, a status bar shows the progress of the 
process.
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Step 8  In the resulting screen, click Finish to complete the installation process.

Step 9  Reconnect all devices.

3.10 Starting ShoreWare Agent Toolbar
The Contact Center Server must be running before you can start ShoreWare Agent Toolbar.

Do not start or run ShoreWare Agent Toolbar from the Contact Center Server. ShoreWare 
Agent Toolbar should be used only on a supervisor or agent PC, based on the license key. 
Running this ShoreWare Agent Toolbar on the server causes unexpected errors and results.

To start ShoreWare Agent Toolbar:

Step 1 From a supervisor or agent PC, select Start > Programs > ShoreTel > ShoreWare 
Contact Center Agent > ShoreWare Agent Toolbar. 

Step 2  If this is your first time logging on to ShoreWare Agent Toolbar, you are asked to 
specify your Extension, Email Account Username, Email Account Password, and 
Server IP Address (which should be filled in by default). Then click OK.
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Step 3  In the ShoreWare Agent Toolbar Logon window, specify your Agent ID, password, 
and Extension (which should be filled in by default), and then click OK.

If you need to change the extension, or other agent information, click Settings 
and specify the appropriate information as explained in step 2, above.

Once connected to the server, Agent Toolbar opens. 

3.11 Installing the Ghostscript Component (Optional)
Supervisors can now export historical reports to the PDF format. However, this feature is 
only available if the freeware component Ghostscript, an interpreter for the PostScript 
language and for PDF, has been installed on the supervisor’s machine. 

The use of Ghostscript is subject to the terms and conditions of the GNU General Public 
License (GPL). You should read the GPL before installing Ghostscript. A copy of the GPL is 
available on the GNU Project web site (at http://www.gnu.org/licenses/gpl.html).

To install Ghostscript:

Step 1 Download and run the most recent version of the ghostscript executable file (for 
example gs864w32.exe). 

The ghostscript executable file can be found at the Sourceforge.net Web site. Point 
your browser to http://sourceforge.net/projects/ghostscript/. Click on the most 
recent Ghostscript release. In the Summary description on the page displayed, click 
on the link provided for more information. A window opens with a list of 
downloadable files. Click on the link for the executable (for example 
gs864w32.exe). In the Security window, click on Run. 

Step 2  In the Self-Extractor window, click Setup.
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Step 3  In the Setup window, you can change the default installation directory and other 
options. Then click Install.

Step 4  From the Windows Printers and Faxes window (Settings > Control Panel > 
Printers and Faxes), choose File > Add Printer.

Step 5  Using the Add Printer Wizard, select the Local Printer Attached to this Computer 
option.

Step 6  Then select the port FILE: (Print to File).
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Step 7  In the Install Printer Software window, click Have Disk. In the resulting window, 
click Browse to locate and select the ghostpdf.inf file. 

The default location of the ghostscript.inf file is C:\Program Files\gs\[version]\lib.

Step 8  Click Open, and then OK. The Ghostscript PDF printer is displayed in the Printers 
list. Then click Next.
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Step 9  In the Name Your Printer window, enter Sybase Datawindow PS in the Printer 
Name field. You must enter this printer name exactly as indicated or the feature 
will not work.

Step 10 Finish using the Add Printer Wizard, selecting the appropriate options. The Sybase 
Datawindow printer appears in the Windows Printers and Faxes window.
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3.12 Installing Distributed IVR Servers (Optional)
Distributed IVR servers can be used to scale the system to more agents. The IVR or media 
servers perform the functions of playing queued music, playing announcements, or self 
service modules. Distributed IVR servers are managed by the main Contact Center Server, 
which distributes the load between the multiple IVR/media servers if more than one server 
is used. Hardware keys or dongles are not required for the distributed server. The 
procedure is for standalone type installations only.

To install a distributed IVR server, on the IVR station machine:

Step 1 Install the Distributed Voice Server (DVS).

Note: A TAPI Application Server License is required for the DVS running the 
distributed IVR server.

Step 2  Configure the route points that you will use as IVR ports. This is done on the 
server where the route points for the Contact Center IRN’s are configured). 

Step 3  Install Contact Center by clicking the setup.exe file in the ShoreTel Contact 
Center IVR folder on the Installation CD. After installation, restart the Contact 
Center Server (see section Installing the Contact Center Server on page 26).

Step 4  On the Contact Center Server, start ShoreWare Contact Center Director. Then 
from the System entity < IVR Ports tab, add a new IVR Client. This process is 
described in the Contact Center Administrator Guide.



Specifying an External Location for Interaction Data (Optional) Installation Guide

Contact Center 6 43

3.13 Specifying an External Location for Interaction 
Data (Optional)
ShoreTel Contact Center provides interaction reports on inbound voice activity including 
IRNs, IVR Port numbers, scripts played, and the agent that answered the call. By default, 
interaction data is generated on your Contact Center Server, and then stored locally. If you 
prefer to have the information stored on an external machine, you can specify an external 
installation. 

To specify an external location for interaction data:

Step 1 Click the setup.exe file in the Contact Center Server Setup folder > ShoreTel CCIR 
folder. A Welcome screen appears. Click Next to continue.

Step 2  You are asked to accept the terms of the license agreement. Then click Next.

Step 3  In the Destination Folder screen, click Next to keep the default destination and 
continue the installation. 

The default destination is C:\Program Files\ShoreTel\ShoreTel CCIR. 

Alternatively, you can click Change to locate and select a different destination 
folder, and then click Next.
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Step 4  In the resulting screen, click Install to begin installation of the software. 

The setup process installs MySQL and the database structure. While the files are 
being installed, a status bar shows the progress of the process.

Step 5  In the resulting screen, click Finish to complete the installation process.

Step 6  Create the ODBC connection to the external machine by choosing from the 
Control Panel > Administrative Tool > Data Sources (ODBC) > System DSN tab > 
c2g.
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Step 7  Click Configure. Use the resulting dialog box to specify the connection 
parameters. The Server IP address should be the IP address of the new external 
CCIR server. You do not need a username or password. Make sure that you change 
the port number from 4306 to 6306. Then click OK. 

Step 8  Create the database connection in Contact Center by selecting from ShoreWare 
Contact Center Director > the System entity > Interfaces tab > DB Connections 
tab. 

Step 9  Select New. In the Properties dialog box, specify the appropriate information for 
the connection. You may want to name the new connection External C2G and 
rename the existing C2G connection Internal C2G.

Additional information on the Properties dialog box can be found in the section 
Configuring External Database Connections in the Contact Center Administrator 
Guide.

Step 10 Identify the external location to store interaction data by selecting from 
ShoreWare Contact Center Director > the System entity > Interfaces tab > CCIR 
tab. 

Step 11 From the Database Connection drop-down menu, select the external CCIR 
connection. Specify the number of days to keep the records and the fields for 
reporting. Then click Save.

Additional information can be found in the section Configuring Contact Center 
Interaction Reports in the Contact Center Administrator Guide.
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3.14 Installing Contact Center in a Thin Client 
Environment
You can install and configure ShoreWare Agent Toolbar in a server-based computing, or 
thin client, environment. In this environment, all desktop applications are installed on a 
server, and users access these applications from the server. Because the server performs all 
the application processing, the user’s PC can be a terminal that has minimal processing 
power and memory. Microsoft Windows Thin Client and Citrix are common examples of 
thin client environments.

Of the Contact Center applications, only ShoreWare Agent Toolbar can be run from the 
server in a thin client environment. The Contact Center Server must be run on the local 
server; Contact Center supervisor applications can only be run on supervisor PCs. 

3.14.1 Installing and Configuring Agent Toolbar in a Thin 
Environment
To install Agent Toolbar in a thin environment, follow the regular installation procedures 
described in the section Overview on page 23. However, you must install the software on 
the client servers rather than on the agent PCs. 

In a thin environment, because Agent Toolbar is not associated with a specific extension, 
you need to change the shortcut for Agent Toolbar so that the agent is prompted for an 
extension number during logon. To do so:

Step 1 From the Start menu, click Programs > ShoreTel > Contact Center >Agent 
Toolbar, and then right-click Properties.

Step 2  In the dialog box, edit the Target field by adding ext=prompt at the end of the 
string. The complete string should look like

C:\Program Files\ShoreTell\Contact Center\Agent\bin\
ShoreWareAgent.exe“ext=prompt”

Step 3  Click Apply. Agents will now have to enter an extension number in addition to 
their ID and password.

3.15 Uninstalling Contact Center 
The process for uninstalling Contact Center involves removing the server, the database 
directories, and the client applications from your machine.

Note: When Contact Center is uninstalled, the database remains untouched. You can make 
a copy of this database and store it elsewhere to access later, or you can delete the database 
as part of the uninstall process.
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3.15.1 Uninstalling the Contact Center Server and Database 
Directories
To uninstall the Contact Center server and database directories:

Step 1 From the Control Panel, select Add or Remove Programs.

Step 2  Select ShoreTel Contact Center Server Software, and then click the Change/
Remove button.

All server software components, excluding the database directory, are removed 
from your system.

Step 3  Manually delete the database directory DbProvider from your system. 

The directory is located on your system where Contact Center was previously 
installed. 

Your server is now ready for a new installation of Contact Center Server.

3.15.2 Uninstalling the Contact Center Client Applications
To uninstall the Contact Center client applications:

Step 1 From the Control Panel, select Add or Remove Programs.

Step 2  Select ShoreTel Contact Center Supervisor or ShoreTel Contact Center Agent, 
and then click the Change/Remove button. 

All client software components are removed from your system.

Your computer is now ready for a new installation of the Contact Center client 
applications.
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C H A P T E R 4

Intergrating Contact Center with
the ShoreTel System

4.1 Overview
The ShoreTel system and the ShoreTel Contact Center Solution connect by way of a 
software interface in an IP network. This interface conforms to the industry-standard 
Telephone Application Programming Interface (TAPI) and allows the system and 
application to exchange call control information. It also allows interaction with audio play 
files and can respond to a caller’s keypad input.

The ShoreTel system interfaces to Contact Center are:

• Destinations: Dialable extensions in the ShoreTel system configured as route points 
that deliver calls to the Contact Center intelligent routing numbers (IRNs).

• IVR Ports: An interface between callers and interactive voice response (IVR) scripts, 
which are configured as route points in the ShoreTel system. IVR ports support caller 
interactions and connect a caller to music or announcements while the caller waits in a 
queue.

• Agents: Normal extensions in the ShoreTel system that an agent has in a call center. 
Agent extensions are monitored by Contact Center to make routing decisions and for 
reporting.

• Trunks: Normal trunks in the ShoreTel system monitored by Contact Center to provide 
reporting.

Integrating the ShoreTel Contact Center Solution with a ShoreTel system requires 
ShoreWare 7.5 or later. This chapter assumes that you have successfully installed:

• ShoreWare Distributed Server software
• ShoreWare Contact Center Server software

In addition, the Contact Center Diagnostics Console must display green for the ACD, IVR, 
and PBX LEDs, as explained in Chapter 3. 
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4.2 The Integration Process
Once the Contact Center Server has been installed, you need to integrate Contact Center 
with the ShoreTel system. This involves:

1. Setting up user groups

2. Identifying server route points

3. Specifying supervisor licenses

4. Setting up agent phones.

5. Setting up data sources used by ODBC connections. 

6. Preparing to use Contact Center Interaction Reports (CCIR) and Event Feeds 
(Optional).

Integrating Contact Center with the ShoreTel system requires familiarity with ShoreTel 
system requirements and administration. For more information, please review the ShoreTel 
Planning and Installation Guide. 

4.3 Setting Up User Groups
Setting up user groups is the first step in integrating Contact Center with the ShoreTel 
system. 

To setup a user group:

Step 1 Launch ShoreWare Director and log on as an administrator.

Step 2 In the navigation frame, click the Users > User Groups link. The User Groups 
page appears.

Step 3 Click Add new. The Edit User Groups page opens.
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Step 4 Enter the following information in the page fields 

• Name: This is a descriptive name of the group you are adding or editing.

• COS – Telephony: This is the telephony features permissions CoS associated 
with the user group.

• COS – Call Permissions: This is the call permissions CoS associated with the 
user group.

• COS – Voice Mail: This is the voice mail permissions CoS record associated 
with the user group.

• Simplified Message Desk Interface Mode: Select from None, External Voice 
Mail, or ShoreTel Voice Mail. Select External Voice Mail if an application 
server is functioning as a PBX for a legacy voice mail system. Select ShoreTel 
Voice Mail if an application server is functioning as a voice mail server for a 
legacy PBX. 
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• Account Code Collection: Select from Disabled, Optional, or Forced account 
code collection for the selected user group.

— Disabled—Account collection is not active for this group.

— Optional—Users are prompted to enter an account code. If no account 
code is entered, the call is completed without account code records.

— Forced—Users must enter an account code for all calls outside the bounds 
of the call permissions set for the user.

• Show Call Manager users a list of account codes when dialing: Enabling this 
option allows Call Manager users to select an account code from the complete 
list of account codes when prompted for an account code. Disable this feature if 
you want to restricts the user’s knowledge of account codes.

• Send Caller ID as Caller’s Emergency Service Identification (CESID): The 
caller ID configured on the User’s page is the telephone number sent to the 
service provider when a user dials an emergency services number (e.g., 911 in 
the U.S.). Default setting is checked on. If this option is not selected, the 
outbound caller ID will be either the user’s DID or the site’s CESID.

• Send DID as Caller’s Emergency Service Identification (CESID): This is the 
telephone number sent to the service provider when a user dials an emergency 
services number (e.g., 911 in the U.S.) from their home phone. If this option is 
not selected and Send Caller ID as Caller’s Emergency Service Identification 
(CESID) is also not selected, the outbound caller ID will be the site’s CESID.

• Outgoing Trunk Groups (Access Code): These are the trunk groups to which 
this user group has access for outgoing calls.

Step 5 Click Save.

Step 6 Repeat steps 4-5 for each user group you need.

4.4 Identifying Server Route Points
Route points enable calls to be terminated and controlled by the Contact Center Server on 
the ShoreTel network.

To identify server route points, you need to:

• Create route points for Contact Center Intelligent Routing Numbers (IRNs)
• Create route points for Contact Center interactive voice response ports (IVRs)

An IRN is a route point for incoming calls that get directed to the Contact Center Server 
Software. With these route points, Contact Center has complete access to call control 
signalling (using TAPI) and the actual voice media stream (using TAPI and wave APIs). 

ShoreTel Contact Center Server Software IVRs are used to transmit queue messages, 
prompts, and music-on-hold to callers currently connected to Contact Center through the 
ShoreTel system.
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4.4.1 Creating IRN Route Points
You must create a route point for each IRN port you plan to use.

To create a route point:

Step 1 Launch ShoreWare Director and log on as an administrator.

Step 2 In the navigation frame, click the Route Points link. The Route Points page 
appears.

Step 3 Click Add new. The Edit Route Point page opens.

Step 4 Enter the following information in the page fields 

• Name. The descriptive name of the IRN route point, such as Sales_IRN.

• Extension. The extension number of the route point. Each route point 
extension must be unique. Any calls sent to this extension are routed to a 
corresponding IRN defined on the Contact Center Server.

• Backup Extension. The backup extension of the route point. If the route 
point does not answer after the specified number of rings (for example, if 
the server is unavailable or there is a network problem), the call is routed 
to this extension. With this feature, you can configure backup call routing 
in case of failures.

• User Group. From this drop-down menu, assign a user group to the route 
point. Select the Executives User Group, which has the appropriate Class 
of Service with full features.

• Route Point Server. From this drop-down menu, select the ShoreWare 
Distributed Server on which the Contact Center Server software resides.

• Mailbox (server). Ensure that this check box is not selected.

• Call Stack Depth. Set the Call Stack Depth to 30. With this feature, you can 
specify the maximum number of simultaneous calls that can be stacked on 
the route point extension. When this number is met, additional inbound 
calls will be routed to the call forward busy destination.
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• Call Forward. These buttons enable you to specify when calls are 
forwarded after the specified number of rings or when the call stack is full. 
The conditions are Always, No Answer/Busy, and Never. Select No Answer/
Busy.

• Busy Destination. When the No Answer/Busy call forward condition is 
selected, calls are forwarded to this extension immediately if the user’s call 
stack is full. You can also forward calls to an external number (access code 
required).

• No Answer Destination. When the No Answer/Busy call forward condition 
is selected, calls are forwarded to this extension after the specified number 
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of rings. You can also forward calls to an external number (access code 
required).

• No Answer Number of Rings. When the No Answer/Busy call forward 
condition is selected, this option specifies the number of times the phone 
rings before the call is forwarded to the No Answer Destination.

Step 5 Click Save.

Step 6 Repeat steps 4-5 for each IRN and IVR port you plan to create in ShoreWare 
Contact Center Director.

Step 7 Restart the Contact Center Server. 

The Contact Center Server needs to be restarted whenever a new route point is 
created.

4.4.2 Creating IVR Route Points
You must create a route point for each IVR port you plan to use.

IVRs are set up similarly to IRNs, with the main difference being that IRNs can have a call 
stack of 16. With IVRs you must set up a route point for each IVR. There can be only one 
IVR per caller connected to the system. In other words, there must be an IVR available for 
every individual caller in the ShoreTel Contact Center queue. IVRs are not assigned to a 
particular Call Group. For example, Sales and Customer Support do not require separate 
IVRs. The IVRs can be used for both Sales and Customer Support.

To create an IVR route point:

Step 1 Launch ShoreWare Director and log on as an administrator.

Step 2 In the navigation frame, click the Route Points link. The Route Points page 
appears.

Step 3 Click Add new. The Edit Route Point page opens.
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Step 4 Type the following parameters that appear on the Edit Route Point page. 

• Name: Type a descriptive name of the IVR route point—such as IVR-01, 
IVR-02, and so forth.

• Extension: This is the extension number of the route point. Each route 
point extension must be unique. No calls are dialed into IVR extensions. 
The extensions are used only for calls originating from Contact Center 
Server. ShoreTel recommends that you use extensions to help manage the 
IVRs.

• Backup Extension: This is the route point backup extension. If the route 
point does not answer after the specified number of rings (for example, the 
server is unavailable or the network has problem), the call is routed to this 
extension. With this feature, you can configure backup call routing in case 
of failures.

• User Group: With this drop-down list, you can assign a user group to the 
route point. Select Executives User Group, which has the appropriate Class 
of Service with full features.

• Route Point Server: Select the ShoreWare Distributed Server on which you 
installed the ShoreTel Contact Center Server Software.

• Mailbox (server): Ensure that this check box is not selected.

• Call Stack Depth: Set the Call Stack Depth to 1. You cannot stack calls on 
an IVR route point. 

• Call Forward: With these buttons, you can specify when calls are 
forwarded after the specified number of rings or when the call stack is full. 
The conditions are Always, No Answer/Busy, and Never. Select Never.

Step 5 Click Save.

Step 6 To configure another IVR route point, click Copy, and then type a new name 
and extension for the new IVR route point.

Step 7 Restart the Contact Center Server. 

The Contact Center Server needs to be restarted whenever a new route point is 
created.

4.5 Specifying Supervisor Licenses
In Contact Center 5.0 and above, supervisor licenses are registered on the server lock 
device. Whether you use the dongle-less approach or continue to use license dongles, the 
consumption of licenses is based on the supervisors who are logged on to the server. (Each 
position requires a license.) The maximum number of supervisor licenses is 128.

ShoreWare Contact Center Director identifies the number of Full Supervisor (Full Visor) 
and Monitor Supervisor (Monitor Only) licenses you have. 

If you are using license dongles, note that:

• The system continues to work with a dongle at the supervisor’s position. 

• In the License Viewer, all supervisor licensing fields indicate 0. Because of this, 
keep a record of the supervisor dongles you are using.
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• The system automatically assigns the license the Monitor Supervisor permissions. 
As needed, you can assign a supervisor Full Supervisor capabilities.

When you add a new dongle-less supervisor, the associated license type must be defined in 
ShoreWare Contact Center Director. Each supervisor who logs on consumes a license of the 
type that was assigned to the supervisor. An additional, undocumented, Full Supervisor 
license is available on the server for support purposes by ShoreTel personnel.

To specify the number and types of supervisor licenses:

Step 1 From ShoreWare Contact Center Director, select the System entity > 
Management tab.

Step 2 Click the Licensing tab (in the left-lower corner of the Management window). 
Licenses other than supervisor roles are also identified in this window.

Step 3 Enter the number of supervisors in the box for each license type. The total 
number you enter cannot exceed the number of purchased supervisor licenses 
of each type.

Step 4 Click Save.
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4.6 Setting Up Agent Phones
ShoreTel Contact Center Solution supports agent positions based on phone only. Agents 
using phones can perform only the following Automatic Call Distribution (ACD) 
management activities:

• Log on to, and log off from, primary groups

• Release 

• Resume

When phone-only agents are logged on, they receive calls as defined by the routing policy 
and are monitored as regular agents by the ShoreWare Supervisor applications.

To set up the Phone-Only agent positions in ShoreWare Contact Center Director: 

• Define four specific Intelligent Routing Numbers (IRNs) in ShoreWare Contact 
Center Director. Each IRN will have a default destination or a predefined ACD 
interactive vice response (IVR) Script.

The ACD actions are performed by dialing the IRN Dial Number and following the 
instructions.

4.7 Setting up Data Sources used by ODBC 
Connections
The Contact Center system uses information from an external database to direct the 
routing of calls, in call control scripts, in dial lists, and for other functions. The system 
relies on Open Database Connectivity (ODBC) to support the API for accessing external 
databases.

Part of the process of configuring an external database connection is to set up the data 
sources used by your ODBC Connections. Refer to the section Configuring External 
Database Connections in the Contact Center Administrator Guide for details.

4.8 Preparing to use CCIR and Event Feeds 
(Optional)
ShoreTel Contact Center Interaction Reports (CCIR) and Event Feeds provide additional 
data on call center activities. 

CCIR reports on inbound voice activity including IRNs, IVR Port numbers, scripts played, 
and the agent that answered the call. If your organization plans to use CCIR, you need to 
do the following:

1. Contact the ShoreTel Developer Network to receive documentation on the database 
schema and support on creating these reports.

2. By default, interaction data is generated on your Contact Center Server, and then 
stored locally. If you prefer to have the information stored on an external machine, 
you can specify an external installation. See the section Specifying an External 
Location for Interaction Data (Optional) on page 43 for details.
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3. Using ShoreWare Contact Center Director, identify the external database connection 
containing date on your inbound voice activity. Refer to Chapter 4 of the Contact 
Center Administrator Guide. Note that the default ODBC connector is 6306.

4. Specify the CCIR parameters using ShoreWare Contact Center Director, as 
explained in the Contact Center Administrator Guide in Chapter 4.

Event feeds allow your organization to access information, through the implementation of 
an API, on agent and group activity using third-party applications. If your organization 
plans to use event feeds, you need to do the following:

1. Contact the ShoreTel Developer Network to receive documentation and support on 
the APIs.

2. Using ShoreWare Contact Center Director, determine the number of connections 
you need. See the Contact Center Administrator Guide for details.

3. Identify the port and event feed properties using ShoreWare Contact Center 
Director. This process is explained in the Contact Center Administrator Guide.
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C H A P T E R 5

Testing Contact Center

5.1 Overview
After you have configured Contact Center you need to test the system to ensure that 
Contact Center is installed properly and operating correctly. This involves creating the 
basic components of the system using ShoreWare Director and ShoreWare Contact Center 
Director, and then verifying that calls are being received and routed correctly. For detailed 
information on using ShoreWare Contact Center Director, refer to the Contact Center 
Administrator Guide.

The process of testing Contact Center involves: 

1. Create a supervisor

2. Add an agent

3. Configure an agent group

4. Create an IRN

5. Configure an IVR port

6. Verify that your call center can receive calls.

7. Verify that an inbound call reaches an agent.

5.2 Creating a Supervisor
Supervisors are responsible for specific groups of agents. They monitor agent performance 
and call center activities. Each supervisor is assigned authorization attributes that allow or 
prevent access to system operations.

To create a supervisor:

Step 1 From ShoreWare Contact Center Director, select the Supervisors entity. 

Step 2 Click New (in the lower-left corner of the window). The New Supervisor 
Wizard opens.

Step 3 Enter the supervisor’s name and password.

Step 4 If this person is already in the system as an agent, select the name from the 
Agent Name drop-down menu.

Step 5 In the Supervisor Permissions area, select the appropriate permissions for the 
supervisor. These permissions are
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• Supervisor Administrator. Can access and modify all system entities.

• Entity Administrator. Can access and modify all system entities, except for 
supervisor details.

• Entity Monitoring. Limited access to supervisor and wallboard 
administration. To configure a supervisor with Entity Monitoring level 
access, the following check boxes must be configured according to the 
functionality that you want to assign to the supervisor

— Can View Agent Manager. Can view and update real-time data in 
ShoreWare Agent Manager.

— Can View Contact Center Reports. Can view and update historical 
data in ShoreWare Contact Center Reports.

— Can Administrate Reader Board. Can modify wallboard scenarios.

Step 6 Click Finish.
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5.3 Adding an Agent
Agents handle contacts routed to them by the ShoreTel Contact Center Solution. Each 
agent is equipped with a telephone, and begins work by logging on to the system. 

To add an agent:

Step 1 From ShoreWare Contact Center Director, select the Agents entity. 

Step 2 From the Agents configuration window, click the Agents tab (in the bottom left 
corner of the window), and then click New.

Step 3 In the New Agent Details window, enter the name, number, and password of 
the new agent in the appropriate fields, and then click Next.
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Step 4 In the New Agent Call Answer Strategy window, click Finish to accept the 
default settings. You can change these settings later. The new agent appears in 
the agents list.

5.4 Configuring an Agent Group
Agent groups form specialized units that receive and place calls. A group is a destination of 
the service entity in ShoreTel Contact Center Solution. Calls delivered to the group are 
presented to the most appropriate agent according to the specified routing policy. 

A service defines how a call is processed. Every incoming call to the call center is assigned 
to a specific service, such as sales of specific products, banking services, or travel agency 
services, and so on.

The process of configuring agent groups involves:

1. Creating a group

2. Adding agents to the group

3. Assigning services to the group

5.4.1 Creating a Group

To create a group:

Step 1 From ShoreWare Contact Center Director, select the Groups entity.

Step 2 In the Groups configuration window, click New (in the lower-left corner of the 
window).
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Step 3 In the New Group Details window, enter a name for the group. For example, 
Sales Group.

Step 4 Click Finish.



Installation Guide  Configuring an Agent Group

64

5.4.2 Add an Agent to the Group

To add an agent to the group:

Step 1 From ShoreWare Contact Center Director, select the Groups entity.

Step 2 Select the group to which you want to add agents. 

Step 3 Click the Agents tab.

Step 4 Select an agent from the list that you want to add to the group, and then click 
Add. 

Step 5 Click Save.

5.4.3 Assigning a Service to the Group

To assign a service to the group:

Step 1 From ShoreWare Contact Center Director, select the Services entity. 

Step 2 In the Service configuration window, click New (in the lower-left corner of the 
window).
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Step 3 In the New Service Details window, use the default options, except for the 
following
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• Name. The name of the service, for example Sales_Service.

• Music Source. The system connects a call waiting in queue to a music source. 
Select CC Script from the drop-down menu and then Sample Music from the 
resulting adjacent drop-down menu.

• Default Destination Group: From the drop-down menu, select the group you 
created previously (i.e., Sales Group).

Step 4 Click Finish.

5.5 Creating an IRN
IRNs are used as entry points to the routing system. Each IRN can be used to define rules 
for routing the incoming call to various destinations, including services. These rules can 
also update the call profile, including the call’s priority and defining the skills required by 
the call.

To create an IRN:

Step 1 From ShoreWare Contact Center Director, select the IRN entity.

The IRN configuration window appears.

Step 2 Click New (in the lower-left corner of the window). 

In the New IRN Details window, use the default options, except for the 
following:
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• IRN. The extension for the group.

• Default Destination. Select Service from the drop-down list, and then 
select the group for the extension.

Step 3 Click Route directly to Default Destination.

Step 4 Click Finish.

5.6 Configuring an IVR Port
The IVR subsystem in the Contact Center performs various activities including auto-
attendant services, announcements, outbound generation of calls, and interactive 
operations with the caller. IVR ports are first configured as Route Points in ShoreWare 
Director. 

To configure an IVR Port:

Step 1 From ShoreWare Contact Center Director, select System entity > IVR Ports tab.

Step 2 In the IVR Ports window, click New (below the Servers list). Then enter the 
name of the distributed server.

Step 3 Click New Range (below the Ports list). Enter the dial numbers created in 
ShoreTel Director, starting with channel 1.
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Step 4 Click Save.

Verify that the contact center can receive calls

5.6.1 Verifying the Call Center Can Receive Calls
Once you have created the basic components of Contact Center, you need to verify that 
your call center can receive calls.

To verify that the call center can receive calls:

• Dial one of the Contact Center extensions. 

You will hear a message from Contact Center. Because no agents are logged on 
and no call handling has been applied, the call will not reach an agent.
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5.7 Verifying an Inbound Call Reaches an Agent
To verify that an inbound call reaches an agent, you need to:

1. Log on to Contact Center as an agent.

2. Call into the system.

5.7.1 Logging on as an Agent

To log on as an agent:

Step 1 Launch ShoreWare Agent Toolbar. 

Step 2 In the ShoreWare Agent Toolbar Logon window, specify your Agent ID, 
password, and Extension (which should be filled in by default), and then click 
OK.

Once connected to the server, Agent Toolbar opens.

5.7.2 Calling into the System

To call into the system:

• From a phone not associated with Contact Center, dial the extension of the group 
of which the agent is a member. 

The call will be sent directly to an agent logged on to a workgroup. ShoreWare 
Agent Toolbar changes from green to yellow, and the phone rings.
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C H A P T E R 6

Upgrading, Maintaining, and
Troubleshooting Contact Center

6.1 Upgrading Contact Center
Upgrading from a previous version of Contact Center is similar to the installation process. 
However, there are a few things you need to be aware of:

• You can directly upgrade to Contact Center 6 from Contact Center 5 or 5.1.

• If you are upgrading from Contact Center Server 5 to 6, you need to also upgrade 
your agents to ShoreWare Agent Toolbar 6. Any attempts to run ShoreWare Agent 
Toolbar 5 using the Contact Center 6 server results in an application error.

For upgrades from Contact Center Server 5.1 to 6, you may need to upgrade your 
agents to ShoreWare Agent Toolbar 6. If an upgrade is required, agents receive a 
system message when logging into Agent Toolbar.

• Windows Server 2008 32-bit support for ShoreTel Contact Center is now available 
for existing Contact Center systems. This means that if you are running Contact 
Center on Windows Server 2003, you can now upgrade to Windows Server 2008.

However, you do need to uninstall the ShoreTel platform before upgrading to 
Windows 2008, and then reinstall the ShoreTel platform. Refer to the ShoreTel 
Planning and Installation guide for specific instructions.

• It is now mandatory for supervisors to use a password to log into Contact Center 
applications. If any of your supervisor accounts do not have specified passwords, 
you must edit the account to include a password. These passwords are now 
casesensitive.

Supervisor accounts are created, and edited, using ShoreWare Contact Center 
Director. Refer to the Contact Center Administrator Guide for details.

• You must manually backup and then reinstall any custom files you have saved in 
the ShoreWare Contact Center directory (such as reports, IVR prompts, and 
databases). These files are deleted during the upgrade process.

• If you plan to upgrade Contact Center supervisor applications using the active 
directory push method, Java 6 or higher must be installed on supervisor PCs. 
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• For previously saved historical reports containing fields removed in Contact Center 
6, the report is automatically updated to no longer include these fields. Reports 
made up entirely of removed fields are displayed without data.

If a report includes user-defined formulas utilizing removed fields, the formula is 
automatically deleted from the system and the report updated to no longer include 
the formula, when upgrading to Contact Center 6. Your users can avoid this 
situation by editing their formulas so that they do not include removed fields, 
before upgrading to Contact Center 6.

6.1.1 Upgrading the Contact Center Server
If you choose to migrate to the dongle-less supervisor approach (as described in the section 
on Licensing on page 11), the server’s dongle is updated with the total number of 
supervisor licenses. If you want to continue using dongles and increase the number of 
licenses, you can buy more license dongles from ShoreTel Customer Service.

To upgrade the Contact Center Server:

Step 1 Insert the ShoreTel Contact Center Solution Installation CD. In the CD’s ShoreTel 
Contact Center Server folder, click the setup.exe file.

Step 2  Follow the instructions in the section Installing the Contact Center Server on page 
27.

6.1.2 Upgrade Methods for Client Applications
The Contact Center client applications (i.e. the supervisor applications and ShoreWare 
Agent Toolbar) can be upgraded either manually or through the active directory push 
method that uses the Microsoft Installer (MSI). Manual installation involves using the 
ShoreTel Contact Center Solution DVD and installing the software on each individual PC.

The active directory installation method simplifies deployments and reduces administrative 
costs. Contact Center is configured, using the Windows Group Policy Object (GPO), to 
automatically push from the server to all computers in your call center. You must have Java 
installed on your supervisor machines for the Contact Center supervisor applications to 
work after installation using the active directory method; and network connectivity is 
required during the installation process. To enable the active directory installation method, 
follow the instructions provided by MSI.

To manually upgrade the Contact Center Client applications:

Step 1 Insert the ShoreTel Contact Center Solution Installation CD.

Step 2  From the ShoreTel Contact Center Supervisor folder for supervisor applications, or 
from ShoreTel Contact Center Agent folder for ShoreWare Agent Toolbar, click the 
setup.exe file.

Step 3  For supervisor applications, follow the instructions in the section Manually 
Installing the Contact Center Supervisor Applications on page 31. For ShoreWare 
Agent Toolbar, refer to the section Manually Installing ShoreWare Agent Toolbar 
on page 35 for the additional steps to follow.

Note: You can only upgrade applications already installed on a PC. This means that 
if the computer only has ShoreWare Agent Toolbar installed, you cannot upgrade 
supervisor applications on that PC.
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6.1.3 Updating Your Contact Center Licenses
Updates to your Contact Center licenses involves applying a new License Key file, provided 
by ShoreTel, to the system. 

To update Contact Center licenses:

Step 1 Shut down the Contact Center Server service from the Windows desktop by 
choosing from the Start menu > Programs > Administrative Tools > Services, and 
then click Stop the Service.

Step 2  Copy the new License Key file (.cif) to the server’s \bin directory located in the 
product root folder (by default d:\ShoreTel\Contact Center server\bin).

The system automatically updates the license keys on the dongle, and then deletes 
the copy of the new License Key file (.cif) from the server. 

Step 3  Restart the Contact Center Server service. 

Step 4  Check that the changes to your Contact Center licenses have been propogated 
throughout the entire system from Contact Center Director > System entity > 
Management tab > Licensing tab.

If the licenseing changes do not appear in Contact Center Director:

Step 1 Launch the Contact Center License Viewer from the Windows desktop by 
choosing Start menu > Programs > ShoreTel > Contact Center > License 
Viewer. The License Viewer appears. 
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Step 2  The message Lock Device Read Successfully appears. Click OK.

Step 3  Record the alpha-numeric License Key serial number that appears in square 
brackets beside Key Contents (eg. [1A2B 3C4D] ).

Step 4  Identify and record the Contact Center build number by choosing from the Help 
menu > About. 

Step 5  Contact ShoreTel TAC at 1-800-742-2348 for assistance.  Have available the new 
License Key file, the License Key file serial number, and the Contact Center build 
number. 

6.2 Backing Up Contact Center
Backing up your Contact Center system is an important part of server maintenance. 
Regular backups ensure that in the event of a server or application failure, the downtime 
and data loss experienced by your call center is kept to a minimum. The location and 
handling of your backups should follow your organization's business continuity policies 
for mission critical systems. It is recommended that you keep a copy off-site to ensure 
availability of all database backups.

The folders and files listed here are critical components of your Contact Center 
configuration. By default, all of these components can be found on the server in 
C:\Program Files\ShoreTel\Contact Center Server\; your installation path may vary.

In addition, your particular configuration may include components that are critical to the 
system, but are not part of Contact Center. These can include ODBC settings or local 
Microsoft Access files required by Contact Center for database integrations. Make sure you 
back up these components as well, according to the manufacturer's specifications.

• Agent Configurations (C:\Program Files\ShoreTel\Contact Center Server\Agents) - 
This folder contains all configurations for Agent Toolbar. This folder is crucial if 
you have any screenpop configurations.

• Active Database (C:\Program Files\ShoreTel\Contact Center 
Server\DBProvider\data\ecc) - This folder contains the active Contact Center 
database. These files should not be touched or backed up while the Contact Center 
MySQL service is running. Doing so can corrupt the database or cause a service 
outage.

• IVR Voice\Wave Files (C:\Program Files\ShoreTel\Contact Center Server\IVR) - All 
of the sound files for the Contact Center IVR applications and announcement plans 
reside in this folder. This includes both custom files and the default language files 
included with Contact Center.

• Email Index (C:\Program Files\ShoreTel\Contact Center Server\bin\EMAILS.DAT) - 
If your Contact Center system is configured for email routing, this file contains the 
index of all of email currently downloaded by Contact Center.

• Email Storage (C:\Program Files\ShoreTel\Contact Center 
Server\Storage\Erstorage) - If your Contact Center system is configured for email 
routing, this folder contains the individual downloaded email files.

• Database Backup (C:\Program Files\ShoreTel\Contact Center Server\backup) - 
Contact Center automatically backs up its database to this folder by default. The 
backup folder contains the entire contents of the data directory in the following 
format:
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xYYYY-MM-DD-hh-mm, where

— x - This value will indicate the type of backup that was made

— d - Daily

— m - Monthly

— w - Weekly

— c - Configuration only backup

— n - Now; On-demand backup from Contact Center Director

— YYYY - The full 4 digit year

— MM - Two digit month

— DD - Two digit year

— hh - Hour of backup completion

— mm - Minute of backup completion

The Contact Center database can be backed up either automatically or manually. You 
should use an automatic backup application to backup the other critical components.

6.2.1 Automatically Backing Up Contact Center
The Contact Center system automatically backs up its database at 22:00 server time every 
night. By default, the database is backed up to the folder C:\Program Files\ShoreTel\Contact 
Center Server\backup. Using ShoreWare Contact Center Director, you can change the 
location of the database backups, the time and date of the execution, and the number of 
generations kept, and generate a backup log. Refer to Chapter 4 of the Contact Center 
Administration Guide for information.

Your backup application should automatically backup the following critical components: 
from their respective directories:

• Agent Configurations

• IVR Voice\Wave Files

• Email Index (if applicable to your configuration)

• Email Storage (if applicable to your configuration)

• Database Backup

It is recommended that you automatically backup these components on a similar schedule 
to the settings in Contact Center. For example, if Contact Center is backing up its database 
every night at 22:00, your backup application should pick up these files a minimum of two 
hours later. All automatic backups should be scheduled for off-peak times for minimumm 
impact to Contact Center functionality, since it adds an additional load on the system.

6.2.2 Manually Backing Up the Contact Center Database
Contact Center is capable of performing on-demand backups of its entire database 
(configuration and historical database). Manual backups should be performed before any 
major changes are done to the system, like upgrading to a newer version of Contact Center, 
to ensure that the system can be rolled back without any data loss. Manual backups should 
be done during off-peak hours, as it puts a load on the Contact Center database. 
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Contact Center can also export its existing configuration, without historical data, to a 
separate database. This kind of backup is usually done in conjunction with ShoreTel 
support for lab work and troubleshooting, since the configuration database is usually 
significantly smaller than the full database.

Details on manually backing up the Contact Center Database are in Chapter 4 of the 
Contact Center Administration Guide.

6.3 Restoring Contact Center
With proper backups, the Contact Center system can be restored from simple issues such 
as configuration mistakes, to rebuilding the system from scratch in the case of catastrophic 
server failure.

You can restore either individual components of Contact Center, or restore the entire 
system.

6.3.1 Restoring Contact Center Components
If individual files are configured incorrectly or damaged, you need to only restore the 
specific component.

6.3.1.1 Restoring Agent Configurations
To restore the agent configuration etas.ini files, all agents must exit Agent Toolbar and be 
logged out of the Contact Center system.

To restore agent configurations:

Step 1 Copy the backup of the Agent folder to C:\Program Files\ShoreTel\Contact Center 
Server \Agents. 

Step 2  Overwrite any existing files.

Agents can now log back into Agent Toolbar; the system uses the newly restored 
files for their configurations.

6.3.1.2 Restoring IVR\Wave Files
The IVR\Wave files can be replaced at any time, even when the server is operational.

To restore an IVR\Wave file:

• Copy the backup files to located in C:\Program Files\ShoreTel\Contact Center 
Server\IVR.

The next call to access an IVR or Wave file uses the newly restored file.

6.3.1.3 Restoring the Database
Restoring the Contact Center database requires shutting down the server, and so should be 
done during non-business hours if at all possible. For emergency restoration, all agents 
should be logged out and incoming calls should be rerouted to alternate destinations until 
you can ensure that the restoration has been completed successfully. In the event of a 
database failure or corruption, keep the defective database in case it is required by ShoreTel 
TAC.
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To restore the Contact Center database:

Step 1 Stop the ShoreTel Contact Center service.

Step 2  Stop the ShoreTel-MySQLCC service.

Step 3  Locate the database you want to restore.

In Contact Center 5.0 and later, the database is located in the folder 
C:\ShoreTel\Contact Center Server\backup\.>d/w/n>>YYY-MM-DD-hh-mm>\Data.

Step 4  Copy and rename the C:Program Files\ShoreTel\Contact Center 
Server\DBProvider\Data folder. This ensures that you have a backup copy of this 
directory if needed.

Step 5  Copy the entire >d/w/n>>YYY-MM-DD-hh-mm>\Data folder into the 
C:\ShoreTel\Contact Center Server\DBProvider folder.

The files in \Data folder are replaced with the current database files.

Step 6  Restart the ShoreTel-MySQLCC service.

Step 7  Restart the ShoreTel Contact Center service.

Step 8  Ensure that the restored data is available.

You can check that the restored data is being used by running a report or by 
launching ShoreWare Contact Center Director and viewing your system 
information.

6.3.2 Restoring the Entire Contact Center System
You should restore the entire Contact Center system in cases of catastrophic hardware or 
software failure. If you have a hardware failure, the new server will need to meet the system 
requirements of required by Contact Center and must have the same IP address as the 
failed server. Refer to Chapter 2 for these hardware requirements.

The newly installed replacement server must be brought up to the level of a new 
installation. This means installing Contact Center and the Distributed Voicemail Software. 
The version of the Contact Center software needs to match the previously installed version, 
even if a newer version is available. This ensures that Contact Center can be put back into a 
functioning state before an upgrade is attempted. For help with a basic installation of 
Contact Center, see Chapter 3.

To restore the Contact Center System:

Step 1 Restore the database, as explained in the section Restoring the Database on page 
75.

Step 2  Restore agent configurations. See the section Restoring Agent Configurations on 
page 75 for details.

Step 3  Restore the IVR/Wave files, as detailed in the section Restoring IVR\Wave Files on 
page 75.
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Step 4  (Optional) Restore data on email by copying the backup of the email index to 
C:\Program Files\ShoreTel\Contact Center Server\bin, and the backup of the email 
storage to C:\Program Files\ShoreTel\Contact Center Server\Storage.

Step 5  Restart Contact Center and verify restoration of configuration and historical 
reporting data.

6.3.3 Moving the Contact Center Installation to a New Server 
Partition
Scenario: Contact Center is installed on a server partition that is running out of space. You 
would like to move the Contact Center installation to a new partition on the same server.

Resolution:

Step 1 Shut down Contact Center and the MySQL services.

Step 2  Copy the /DbProvider/data folder to a backup location.

Step 3  Uninstall Contact Center, and then reboot the server.

Step 4  Delete the Contact Center Server folder on the server.

Step 5  Reinstall Contact Center on the correct partition, and then reboot the server.

Step 6  Shut down Contact Center and the MySQL services.

Step 7  Overwrite the /DbProvider/data folder with the backup copy from the previous 
installation.

Step 8  Restart Contact Center and the MySQL services.

6.4 Troubleshooting Contact Center
This section provides information on problems or errors you may encounter when 
installing and using ShoreTel Contact Center.

6.4.1 Error 1720
Error 1720: There is a problem with this Windows Installer Package. A script required for 
this install to complete could not be run. Contact your support personnel or package 
vendor.

Scenario: Windows Server 2008 is attempting to install Contact Center. The error appears 
during the Contact Center installation process, when the installer is creating the database 
schema.

Resolution: In the Windows Control Panel, turn on the Windows firewall. You are 
prompted to start the firewall service, click Yes. Then turn off the Windows firewall; if you 
leave the firewall on, the server cannot find the license dongle.
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6.4.2 TMS or DTAS Error
Scenario: If a TMS or DTAS error occurs, Contact Center automatically logs out all agents 
from ShoreWare Agent Toolbar and the system.

Resolution: You must manually restart Contact Center in order to ensure correct call 
routing after the error, and to enable your agents to log back onto the system.
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A P P E N D I X A

Installation Worksheets

A.1 Overview
To simplify the installation process, use the attached worksheets.

A.2 Site General Information

A.3 Contacts

A.4 About the Company
_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

A.5 Network Information

Site Name ___________________________________
Address ___________________________________

___________________________________
___________________________________

# Name Title Phone #1 Phone #2 Email

Server Type __________________ Version ________________________________
ShoreTel Contact 
Center Server IP

__________________

Backup Information
Backup Location __________________ Schedule _______________________________
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A.6 ShoreWare Agent Manager Computers
# Computer Name Type Full/Monitor OS (NT/2K/XP/Vista) Comments

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

25.

26.

27.

28.

29.

30.

31.

32.
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A.7 ShoreWare Agent Computers
# Computer Name Type Full/Monitor OS (NT/2K/XP/XP) Comments

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

25.

26.

27.

28.

29.

30.

31.

32.
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Glossary

Agent: Agents handle contacts routed to them by the ShoreTel Contact Center Solution. 
Each agent is equipped with a telephone, and begins work by logging on to the system. 

The ShoreTel Contact Center Solution supports two types of agents:

• The first type of agent is equipped with the ShoreWare Agent Toolbar Software and 
a telephone, and begins work by logging on to the system. To log on, each agent 
enters a unique agent identification ID and password.

• The second type of agent is equipped with a telephone only. These agents begin 
work by logging on to the system. To log on, each agent dials a predefined 
intelligent routing number (IRN) and, at the voice prompt, dials their agent ID.

Agent Group: Agent groups form specialized units that receive and place calls. A group is a 
destination of the service entity in ShoreTel Contact Center Solution. Calls delivered to 
the group are presented to the most appropriate agent according to the specified 
routing policy. 

When all the agents in a group are busy or unavailable, the ShoreTel Contact Center 
Solution places calls in a queue and activates the Announcement Plan, as well as 
overflow and interflow actions, as defined.

When no agents are logged on to the group, calls are routed to the No Agents 
destination defined on the service.

Agent Search Criteria: The method by which an available agent is selected for a call that 
enters the service.

Agent State: A graphical representation of the agent’s status indicates the activity and the 
state of an agent at any given time. 

Agent Station (or workstation): Agents use an agent workstation composed of a Windows-
based PC and a phone, or else just a phone. Each agent is defined in the ShoreTel 
Contact Center Solution and is identified by a unique ID and password. The ShoreTel 
Contact Center Solution supports the “free seating” concept and routes calls by agent 
ID.

Automatic Call Distribution (ACD): The ShoreTel system uses ACD to distribute calls in 
the contact center. ACD activity and performance within the ShoreTel Contact Center 
Solution is statistically evaluated, recorded, and reported.

Automatic Number Identification (ANI): ANI is the series of digits sent by the Public 
Switched Telephone Network (PSTN) to the ShoreTel System. An ANI contains the dial 
number of the caller. 

Average Speed of Answer (ASA): ASA is the average time it takes a call to be answered 
from the time it was received.

Call Answer Strategy: The method by which an incoming call is routed to the agent, when 
the agent becomes available. The strategy includes two stages: 1) Determining the set 
of calls to be considered for routing and 2) Selecting from that set a single call to route 
to the agent. 

Call Priority: A priority level on a scale of 1–100 is assigned to each call, where 100 is the 
highest priority. The priority is initially set to a defined value at the IRN level and 
increases by wait time, as defined. 
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Call Profile: A collection of dynamic properties attached to each ACD call. 

Dial Numbers: Dial numbers are used within the ShoreTel system to identify entities that 
can be a source of, or destination for, a call. For instance, an extension number specific 
to the group identifies an agent group. When this number is dialed, the call enters the 
group as an ACD call. Incoming trunks are routed to this extension number to connect 
callers to the agent group.

Dynamic Host Configuration Protocol (DHCP): DHCP enables individual computers on 
an IP network to extract their configurations from a server (the DHCP server) or 
servers, reducing the work of administering a large IP network. 

Extension Number: An extension or directory number.

First Announcer: An announcement that is heard once when a caller first enters the queue.

Historical Reports Interval: A system-wide amount of time defining the increments by 
which all collected data and statistical information is stored in the database for future 
analysis and reporting. 

Incomplete Call Destination: The destination of calls that have not been answered or 
handled to completion. This is a system-wide destination that completes the handling 
of such calls. 

Interflow: Interflow transfers calls waiting over the amount of interflow time to a different 
destination. Interflow parameters are defined per service.

Intelligent Routing Number (IRN): IRNs are dial numbers used as entry points to the 
routing system. Each number can be used to define rules for routing the incoming call 
to various destinations, including services, call control scripts, and devices. The IRN is 
reached from the ShoreTel system by dialing the extension number assigned to the 
route point, which is then sent to the corresponding IRN.

Lock Device: The software lock device, or dongle, attached to the USB port. The 
ShoreWare Contact Center Server Software and ShoreWare Supervisor applications 
cannot be installed or operate without this device.

Mandatory Announcer: An announcement heard by all callers upon entering the service, 
regardless of the availability of agents.

Multiple Document Interface (MDI): ShoreTel Contact Center Solution screens are based 
on the MDI display method. Using this method, all the ShoreTel Contact Center 
Solution work windows are contained within the work area of the main MDI window. 

The work area is the region inside the main window where all the work takes place, 
and where the output is displayed. The supervisor uses work windows to define 
contact center entities, and view, generate, and modify reports. There may be several 
active work windows open at any given time for each ShoreTel Contact Center Solution 
application (including minimized windows). In addition, MDI enables you to tile or 
cascade multiple windows in the main window.

Overflow: An algorithm designed to improve the way waiting calls are handled, by 
expanding the number of potential agents to answer the call. Overflow is activated after 
the overflow timeout, by adding groups of agents as the destination of the call.

Real-Time Interval: The real-time reports reflect the actions and activities performed by 
monitored ACD entities on the contact center, along with various performance 
information based on statistic calculations. The ShoreTel Contact Center Solution uses 
a sliding window time period and reports statistical performance information over this 
amount of time.

The sliding time period is managed by the real-time interval and may be differently 
defined for each group, with intervals varying from 3 to 60 minutes. The real-time 
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interval “moves” in increments of 1/60 of the defined period. (That is, if the defined 
period is set to 15 minutes, the increment will be 15 seconds.)

Reports: To obtain accurate performance information about the contact center, a 
supervisor or manager can use the ShoreTel Contact Center Solution reports. These 
reports provide a picture of ACD activity that can be assessed and analyzed. The 
information can be displayed as either real-time or historical reports in various formats.

Real-time reports display the dynamic status of ACD activity. Historical reports 
summarize past ACD activity, after it is recorded in the database.

Report Template: The ShoreTel Contact Center Solution comes with a set of predefined 
report templates (default reports), which cover the full range of information available. 
In addition to predefined report templates, you may also design and customize user-
defined templates for historical reports.

Templates provide a virtually unlimited reservoir of report formats that can be 
generated in a simple and straightforward manner. You can also modify templates for 
your specific requirements. 

Templates can be saved as private or public, with unique names for future use.

Routing by ANI/Caller ID: This item describes how calls are routed by ANI / Caller ID.

A call enters the IRN with ANI. (ANI is information about the source of the call 
received from the central office.) The IRN has the option to route the call by ANI. The 
ShoreTel Contact Center Server then goes to the customer’s table or an external 
database, and searches for the customer according to the ANI received.

A call enters the IRN without ANI. Whenever a call enters the IRN without ANI, the 
IRN sends the call to a Call Control Script (CCS). The ShoreTel Contact Center Server 
sends the call to the defined CCS. This CCS prompts the user to enter the customer 
information and copies it to the ANI field in the call profile. The call returns from the 
CCS to the IRN. The system then goes to the customer’s table or an external database, 
and searches for the customer according to the ANI entered by the CCS.

If the customer is found, the ShoreTel Contact Center Server uses the customer 
information and tries to route the call, using that information.

If the customer is not found, the call is routed to the default destination of the IRN (or 
one of the IRN’s alternate destinations).

Routing Method: The ShoreTel Contact Center Solution offers the contact center 
administrator a variety of call routing methods, including Route by ANI, Best Fit, 
Agents Skills, and others.

Script: Call Control Scripts define call treatment. A script is a set of actions that is 
performed on a call according to logical and/or physical events (for example, “Route 
the call to a specific destination”. Or “Let the caller hear music or special 
announcements”.).

Secondary Announcer: Announcements played periodically while the caller is waiting in 
the queue.

Service: A service defines how a call is processed. Every incoming call to the contact center 
is assigned to a specific service, such as sales of specific products, banking services, or 
travel agency services, and so on. 

Service Time Interval (STI): STIs are the time periods for which the call service is 
monitored for real-time or historical statistical data purposes. The STI is determined for 
each group in the system in ShoreWare Contact Center Director. It is used to generate 
histograms for statistical analysis.
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ShoreTel Contact Center Server: The ShoreTel Contact Center Server provides intelligent 
routing for the contact center, as well as enhanced skill-based routing functionality for 
calls to agents. 

Super Group: A super group is a collection of agent groups aggregated for statistical and 
reporting purposes. Super groups may contain several agent groups. They are used 
mainly to represent the hierarchy of the company–division–department. An agent 
group may belong to more than one super group.

Supervisor: Each supervisor is responsible for specific groups of agents. Using the 
ShoreWare Supervisor Applications, supervisors monitor agent performance and the 
contact center activities. Each supervisor is assigned authorization attributes that allow 
or prevent access to system operations.

Authorized supervisors can determine the routing plans for ACD calls, as well as which 
information is included in reports. In addition, supervisors can change the information 
displayed on the Wall Boards under their control. They can also be assigned privileges 
for managing groups, including adding and removing agents for specific groups.

Supervisor Applications: Supervisor Applications include the ShoreWare Agent Manager 
and Contact Center Reporting software, which provide real-time online information 
and historical reports on the performance of the contact center. 

Target Service Factor (TSF): TSF is the percentage of calls answered within the Target 
ASA, out of all the calls that are routed to the group. This factor indicates how well the 
group is providing the level of service defined for it, based on the Target ASA. 
Abandoned and overflowed calls are considered as answered after the Target ASA.

Transmission Control Protocol/Internet Protocol (TCP/IP): TCP/IP is the basic 
communication language or protocol of the Internet. In many places, it is used as a 
communication protocol in intranets and extranets. 

Trunk: A trunk is a channel of conversation between the Public Switched Telephone 
Network (PSTN) and the ShoreTel System. These lines carry all the ACD calls, as well 
as external non-ACD calls, to and from the system.

Trunk Group: A trunk group is a collection of trunk lines grouped together to act as a 
single line unit, with its own specific name and extension number. A trunk group is 
usually routed to a specific agent group.

Wrap-Up Codes: A code entered by an agent during the wrap-up time in order to provide 
additional information for evaluating the actions of the contact center. In most cases, 
wrap-up codes provide information for evaluating calls for reporting purposes, 
including types of call (request or complaint); level of required action (urgent, regular, 
or low); status of the deal (closed, needs recall); and so on.

Wrap-Up Time: An amount of time at the end of an ACD call in which an agent performs 
additional operations related to the call. This wrap-up time is set on the ShoreTel 
system, and reported by the ShoreTel Contact Center Solution for each agent. It is also 
reported as part of the Treatment Time (that is, the time it took to handle the call from 
the time the call entered the system).
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